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1.  OVERVIEW 
This help guide documents CDOT Plan Production processes using OpenRoads Designer & related tools.   The 
primary topics include but are not limited to Named Boundary’s, Sheet Creation, Annotation, and Sheet Index.  
The Sheet Index section covers sheet management and the steps of how to create and put together a project plan 
set ready for Ad.  This includes how to apply page number on a plan set, how to insert and or remove pages from 
plan set, and apply page number to the final plan set.   
 
The initial dataset is shown below.  Note that the names of the files used and created in this guide are named 
for clarity and not necessarily the file naming convention used by CDOT.   
Project 12345 

 

Roadway Files 

  
Survey Files 
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2. DRAWING PRODUCTION OVERVIEW 

2.1 Section Overview 
This section provides a high-level overview of the Drawing Production Tools available in OpenRoads Designer that 
are discussed in this document.  Detailed plan production steps are available in other sections of this document.  
Also included in this section is an overview of the CDOT Ribbon Tab tools.   

 
 

• Place Table – Allows you to Place a Table from a Report or an Excel file.   
• Civil Labeler – The civil labeler is a production-focused annotation tool for the civil environment.  Stored 

as part of a workspace, label definitions are easily shared while maintaining constancy and compliance 
with standards. Label definitions bring together Text Favorites, Text Styles, Dimension Styles, Element 
Templates, custom prompting, border frames, and lock settings into a single, repeatable label definition.  
Examples of use are intersection, station/offset, station/elevation, offset/elevation, etc. and this tool 
does allow bulk selection of intended elements to label.   

• Annotations – This is a much more automated method of labeling than the Civil Labeler but generally not 
as flexible with customization.  The tools are feature driven by Annotation Groups that are associated 
with Feature Symbologies. Examples of use are Alignment stationing annotation, profile annotation, 
displaying ROW on cross-sections, etc.   

• Cross Section Navigator – This tool allows you to easily browse between cross section drawing models 
that have been previously generated through the Named Boundary Cross-Section Sheet creation process.  
Note that this only looks for drawing models in the active drawing file.   

• Named Boundary - Places named boundary elements which define the location from which Sheets are 
generated.  Named Boundaries can also be used to identify where you wish to calculate earthwork.   

 
NOTES:  

• Annotation should generally be performed in the Design or Drawing models.  The only annotation work 
that should be done in a Sheet model is when you use the Place Table command and title block info. 
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2.2 Sheet Production Process 
The overall sheet production process using the ORD Named Boundary process is:  
1) Place Named Boundaries which identify where you want to cut sheets. Drawing Seeds are chosen 

during the Place Named Boundary process to pre-populate the dialog settings. 
2) Invoke the Named Boundary Manger dialog which is utilized to manage Named Boundaries and 

ultimately kick-off the Create Drawing process.   
3) The Create Drawing dialog is the dialog invoked through the Named Boundary Manager dialog that  

actually creates Drawing & Sheet models & references the Drawing models to the Sheet models.   
Annotation Groups are defined on this dialog as well to annotate the XS grid, Plan Annotation such as 
matchlines, profile annotation, etc.   

 
NOTES:  

• CDOT does offer another method outside the Named Boundary process of creating some of the General 
Sheets.  This process is available on the CDOT Ribbon Tab and is documented in this manual. 

• The CDOT Create General Sheet tool only creates a Sheet model (a Drawing model is not created). 
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2.2.1 Named Boundary Tool 

Step 1 of the Sheet production process is place Named Boundary shapes that define the areas where you 
wish to generate sheets at.  We will utilize the Named Boundary tool quite often in this help guide so we will 
provide an overview of the tool below.  We will also show the Named Boundary Manager dialog.  The modes 
(a,b,c, etc.) are defined below.  Drawing Seeds are chosen to populate the default values on this dialog, 
specify the sheet cells placed when sheets are created, and also specify Annotation groups used when 
creating sheets.   
 

 
NOTES:  

• Red modes to the right are placed along an 
alignment. 

• Blue Modes B, G, & H are not generally 
used so not discussed in detail in any of the 
steps below. 

• If you check the Create Drawing checkbox, 
you will proceed right into the sheet 
creation process as soon as the Named 
Boundaries are placed.  This is a viable 
option but it is more practical to go through 
the Named Boundary Manager discussed 
below to generate Drawing & Sheet 
models. 

a) Civil Plan Mode - (Place along an alignment – 
Plan, Double Plan, Plan Profile, & ROW Plan 
Drawing Seeds, Survey Plan, Roll Plots, etc. are 
available. ) 

b) Civil Plan By Element – (Lets you place a 
named boundary from an existing element.) 

c) Civil Profile - (Profile, Double Profile, Plan 
Profile, Driveway Profile Drawing Seeds) 

d) Civil Cross-Section - (Cross-Section Drawing 
Seeds @ various scale are available) 

e) Civil Cross-Section - 2 Point (Two point method 
of creating a Cross-Section Named Boundary.  
You would use this primarily for skewed X-
Sections (at culverts, etc.)) 

f) From Drawing Boundary -  (Plan not along an 
alignment) (Roadway Detail-Title-Plan-Typical), 
ROW Title & Plan, Survey Plan, etc.) 

g) By 2 Points – (Lets you place a named 
boundary by interactively defining a 
rectangular element with two data points.) 

h) By Polygon – (Lets you place a named 
boundary by interactively defining vertices of a 
polygon with data points.) 
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2.2.2 Named Boundary Manager dialog 

As mentioned earlier, the Named Boundary Manager dialog is used to manage (Delete, rename, etc.) the Named 
Boundaries in the DGN file.  It is also Step 2 of the Sheet production process unless you check the Create Drawing 
item on the Place Named Boundary dialog above.  If this is checked you will skip the Named Boundary Manager 
dialog and go straight into the Sheet Production process.   
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2.2.3 Create Drawing dialog 

Step 3 and final step of the Sheet Production process is the Create Drawing dialog.  This dialog is pre-populated 
and generally no edits are required.   Ultimately, this dialog controls the creation of the Drawing & Sheet models.  
In this dialog you can; 

1) Specify to create the sheets and drawing models in the same file the Named Boundaries are in or in other 
files.   

2) Change scales 
3) Change Annotation Groups,  
4) Control Drawing & Sheet Model names 
5) Add the Sheets created to the Sheet Index 
6) Specify a Sheet Model that has been created in advance with the Sheets setting below although this is 

generally set to (New) as shown below. 
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2.3 Sheet Index 
Sheet Index is found on Project Explorer as shown below and is used to manage DGN files that contain your 
Sheets.  It’s extremely important that all Sheets are created in a Sheet model because Sheet Index will only 
recognize sheet models as sheets.  In other words, Sheet Index will not recognize a sheet cell placed in a design 
or drawing model. 
 
The Sheet Index: 

• Aids in Sheet naming/numbering 
• Allows index property edits by users of fields like Hwy No., County, Project Code, etc. which automatically 

populate text fields that have been established in the Title Blocks. 
• Can generate an Index of the Sheets as a Table 
• Transfers the Sheets to Print Organizer for PDF production or printing. 
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2.4 CDOT Ribbon Tab 
 
CDOT also provides many Drawing Production Tools through its custom CDOT Ribbon Tab shown below.   

 
The Ribbon Group categories of the CDOT Ribbon tab are described below with more discussion in the GENERAL 
SHEETS & HATCHING primary sections.   
 

• Drafting 

 
These are drafting tools with a mix of commands as described below: 

o Linework tools that set active attributes & kicks off the Place SmartLine tool. 
o Patterning selections that set the Pattern Cell of the Pattern Area command & kicks off the 

Pattern Area command. 
o Various MicroStation tools including the Revision Bubble (Cloud By Points command) 
o Custom tools  

 Rotate Cells 
 Point Labeler 
 Modify Level Display 
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• Sheets  

 
o Create General Sheets – Covered in detail under the GENERAL SHEETS section, this is an option 

for creating sheets outside of the Named Boundary process that only creates a Sheet Model (No 
Drawing model is created).  This would be ideal for tabulation sheets. 

o Other tools 
Sheet Drafting tools Sheet Border Cells 
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• Design  

 
o Roadway, Fence, & Guardrail generally set the correct symbology of an element.  

Roadway  Fence Guardrail 

 

  
o Typical Generator – CDOT tool to create Typical Sections. 
o Phasing – Hatching settings for Construction phases.  

 
 

• Hydraulics 

  
o Links to IDF Convertor & Drainage Design Manual 
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• ROW/Survey 

  
 

o Contains tools to set symbology and place cells for ROW & Property related items.   
o Right of Way expanded: 

 
 

o Survey expanded: 
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3. GENERAL SHEETS (No Alignment) 

3.1 Section Overview 
This section covers the process of creating General Sheets normally found at the beginning of the plan 
set.  These include but are not limited to the following sheet types:   
Title Sheet 
Index (Generally included on the Title Sheet) 
M&S Standard Plans List 
Typical Sections 
General Notes 
Summary of Approximate Quantities 
Structure Tabulation 
Earthwork Summary  
Surfacing  Tabulation 
Guardrail/Fencing/Delineator Tabulation (Included on separate sheets on large projects) 
Any Civil model Detail Sheets 
 
These sheets are not generated along an alignment such as Plan/Profile, Cross-Section, Traffic Control 
sheets, etc.   There is actually a couple of different methods for creating these type of sheets. 
 
1. Place Named Boundary Tool (From Drawing Boundary). 

   
NOTE: Listed above are the current Drawing Boundaries available. 
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2. Create General Sheets Ribbon tool found under the CDOT ribbon tab shown below and discussed 
more in depth in the sections below.   These commands create a Sheet Model but not a Drawing 
model like the Named Boundary process does.   

 
 
NOTE: A few of the ROW & Quantities/Tabulation Sheet Types are shown above. 
 
We will create a couple of these type sheets using both of these methods in the next couple of 
sections.   
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3.2 Place Named Boundary (From Drawing Boundary) 

Annotation should normally be performed in the design or drawing models when using the Named Boundary 
process to create sheets. 

3.2.1 Creating a Title Sheet  

In the steps in this section, we are using a DGN with Section lines, roads, county boundaries, etc.  already present 
in the correct GCS.   
 
There are other instructions (word docx links below) available outside this manual that are a better resource than 
the steps in this section of creating a Title Sheet because of some of the annotation processes documented there.  
The word document links below guide you through the process of creating a title sheet vicinity map using GIS 
data. The GIS data has been compiled from a number of shape files into a single DGN file. GIS attribute data is 
used to label the drawing for the title sheet vicinity map through the use of the Civil Labeler.   
 
https://www.codot.gov/business/designsupport/cadd/ord/about 

• Workflow ORD 1- Using GIS Data For A Title Sheet Vicinity Map For ORD 10.08 Version(docx) 
• Workflow ORD 1- Using GIS Data For A Title Sheet Vicinity Map For ORD 10.10 Version(docx) 
• GIS Vicinity Map workflow file for ORD 10.08 Version.dgn 
• GIS Vicinity Map workflow file for ORD 10.10 Version.dgn 

 
1. Create & enter the title sheet DGN file (Using a 2d Seed file) -> 12345_RD_Title.DGN. 

 
2. Reference the file 12345_RD_Geometry.dgn & fit the view. 

 
3. Reference the file 12345_RD_Weld County.dgn.  Note that this file is a derivative of the GIS Vicinity map 

above and created for this manual.  Your drawing should appear similar to what is shown below.   
 

 
 

  

https://www.codot.gov/business/designsupport/cadd/ord/about
https://www.codot.gov/business/designsupport/cadd/ord/workflow-ord-1-gis-title-sheet
https://www.codot.gov/business/designsupport/cadd/ord/using-gis-data-for-a-title-sheet-vicinity-map-for-ord-10.10
https://www.codot.gov/business/designsupport/cadd/ord/gis-vicinity-map-for-ord.dgn
https://www.codot.gov/business/designsupport/cadd/ord/gis-vicinity-map-for-ord-10-10-version.dgn


GENERAL SHEETS (No Alignment)  Place Named Boundary (From Drawing Boundary)  

                                     20  
               

4. Select Drawing Production -> Place Named Boundary. 
 

 
 

5. Use the From Drawing Boundary method, fill out the dialog as shown below, position the Named 
Boundary similar to what is shown below, and then Data Point to place the Named Boundary. 

 

 
 

NOTES:   
 You will generally change the scale as needed to determine the correct size of the Named 

Boundary. 

  - Modes are Place Single, Place an Array, Place along a Path respectively.   
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6. Select the Named Boundary Manager button. 
 

  
 

7. Expand Other Groups until you see the Title boundary and follow the steps below.  
 

 
8. Change the scales if needed, review the Create Drawing dialog, and choose OK.  
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9. The title sheet will be created in a new sheet model. 

 
 

10. Open the Models dialog and review that two models were created a shown below.   

 
 
NOTE:  
Title is a Drawing model and Title [Sheet] is a Sheet model. 
 

11. You can double click any of these models and it will be opened in all views.  Close the models 
dialog and choose Title from the View Groups at the bottom of the MicroStation window. 

 
12. Review the Title model.  This is the ideal location for any Annotation that needs to be added. 

 
  



GENERAL SHEETS (No Alignment)  Place Named Boundary (From Drawing Boundary)  

                                     23  
               

3.2.2 Typical Section Sheets (From Drawing Boundary, Array) 

1. Open 12345_RD_Typical Sections.dgn  
2. Choose the Place Named Boundary tool.  

 
3. Choose the From Drawing Boundary method and set the dialog as shown below.  

 
 

4. Move your cursor to show the location of the 1st sheet as shown below.  
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5. Data Point to place the named boundaries as shown below.  Two were placed since we set 1 Row & 2 
Columns on the dialog.  

 
 

6. Select the Named Boundary Manager button. 
 

  
 

7. Expand Other Groups until you see the TS boundary group and follow the steps below.  
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8. Change the scales if needed, review the Create Drawing dialog, and choose OK.  

 
 

9. The typical section sheets will be created in new sheet models. 

 
 

10. Review the Models created.  
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3.3 Create General Sheets (CDOT menu) 
As noted earlier, these commands create a Sheet Model but not a Drawing model like the Named Boundary 
process does.  Much of the time tabular or pasted data from excel/word documents are used as the content 
on these sheets.    
 
Unlike sheets created through the Named Boundary process, annotation (generally tabular or pasted data 
from excel/word documents) is performed in the sheet models of General Sheets created through the CDOT 
ribbon tab because no drawing model is created through this process. 
 
1. Create the file 12345_RD_Tabulation_Fencing.dgn & enter this file.   
2. Choose the Create General Sheets -> Quantities/Tabulation Sheets -> Fencing/Guardrail 

 
 

3. A sheet model is created & opened as shown below.  Note that no Drawing model was created nor are 
there any reference files to the sheet model.  You will add tables, estimated quantities, etc. as needed 
here.  We will perform some of these processes in the next section.   
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3.4 Place Table 
Found under Drawing Production is the Place Table command shown below.   

 
This tool (shown below) allows the user to: 

a. Place an empty table 
b. Place a table from a report 
c. Place a table from an Excel file.   

 

3.4.1 Place an Empty Table (Using a Drawing Seed) 

 
1. Remaining in 12345_RD_Tabulation_Fencing.dgn, choose the Place Table command.  
2. Set the dialog as shown below.    

 
 
NOTES:  

• At this time, there is only one Seed (Tabulation of Fence) but more should be added soon.   
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3. Place the Table as shown below.  

 

3.4.2 From an Excel file 

Below are general steps for using the Place Table command to place rows/columns from an excel file. 
 

1) Choose the Place Table command. 

 
2) Set the mode to From File (1) and then choose the XLSX file (2). 
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3) You are prompted with the following dialog.  Config as needed to place the worksheet/row/columns as 
needed. 

 
4) Data Point to place the Table.   

 
5) You can then select this table and notice the ribbon changes to excel commands.  You can perform edits 

such as resizing, Refreshing data from the datasource, etc.   
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3.5 Paste Special 
You can copy/paste data from an external app such as word or excel, into a DGN through the Paste Special 
command.  We will create a General Notes sheet in the steps below.    
 
1. Create the file 12345_RD_General Notes.dgn (using a 2d seed file) and enter this file.   
2. Choose the Create General Sheets -> General Note Sheets -> 1 Sheet 

 
 

4. A sheet model is created & opened as shown below.  Note that no Drawing model was created nor are 
there any reference files to the sheet model.  You will paste the General Notes from a word document 
here in the next few steps.   
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5. In ProjectWise or Windows Explorer, open the file GENERAL NOTES.docx (that should be included in the 
dataset) with Microsoft Word.  Select the text as shown below, right click, and choose Copy.  

 
6. Moving back to the General Notes DGN file, choose the Home -> Selection Paste Special command.  

 
7.  Select the Embedded Microsoft Word Document Data Type. 

 
NOTES:  

• Embedded – The copied contents is added and actually saved in the DGN file and future edits are made to 
the embedded file by double clicking the image in ORD to open the document up in Word to edit.  

• Linked – The copied content is added to the DGN file but edits are still made outside of ORD in Word to 
the original document and then the ORD Update link tool is used to update the text. 
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8. You should be prompted with the following options on the Tool Settings dialog.   

 
 

9. With the settings above, observe the bottom left of the ORD window.  You should be seeing the following 
prompt.  

 
 

10. Data Point in the top left area of the sheet and then data point in the lower right of the sheet making sure 
the rectangular shape stays within the sheet boundaries.  
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11. Below is the copied text.  

 
 

12. Double Click the text area and the embedded object is open for edit.  We will not perform any edits here 
so close Microsoft Word. 
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4. CONTAINER DGN FILE 

4.1 Section Overview 
This section covers the process of setting up a Container DGN file that contains references of the files that 
will be used in the plan production process.  This is not a requirement but rather a best practice so you 
can reference just the container file instead of multiple files when preparing the named boundary of 
sheet files.     

4.2 Creating a Container file 
 

1) Create & enter the 12345_RD_Container for Plans.DGN file (Using a 2d Seed file)  
 
2) Reference the following files: 

12345_RD_Corridor-CR44.dgn 
12345_ RD_Corridor-Intersections.dgn 
12345_ RD_Corridor-US85.dgn 
12345_ RD_Drainage.dgn 
12345_ RD_Drives.dgn 

 

12345_ RD_Geometry-Annotation 
12345_ RD_Geometry.dgn 
12345_ RD_SURV_Topo.dgn 
12345_ RD_Terrain.dgn 

 

 
The Reference File Attachment Properties dialog is shown below: 
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3) Select the terrain and from the context menu, Set As Active Terrain Model. 

 
 

4) Open the Reference dialog and turn Display OFF for the CDOT Default-3D model.  

 
5) Close the Reference dialog and from the Reset menu, choose Views Plan/3D. 

 
6) Choose Save Settings. 
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5. PLAN/PROFILE SHEET CREATION 

5.1 Section Overview 
This section along with  sections 8-10 will cover how to use Named Boundaries through ORD’s Drawing 
Production ribbon tab to generate sheets along alignments.  The types of sheets normally generated with 
this method include the following type sheets: 
 
Plan & Profile Sheets 
Interchange Plan Sheets 
Profile of Ramps or Side Streets or Driveways 
Bridge Plans and Details 
Retaining Wall Plans and Details 
Structure Cross Section (Culvert Profiles) 
Stormwater Management Plan 
Wetland Mitigation Sheets 
Utility Plans 
Phasing and Detour Plans 
Traffic Control Plans 
Permanent Signing & Marking Plans and Details 
Traffic Signal Plans and Details 
Lighting Plans and Details 
 
We will create Plan & Profile sheets for CR44 in Section 5, Plan only sheets for US85 in Section 8, Profile 
Sheets for US85 in Section 9, & Roll Plots in Section 10.   Many sheet specific processes (Scales, modifying 
named boundary locations, adding references, levels, deleting sheets, etc.) are covered in Section 6 and 
can be applied in Sections 8-10. 

 

Annotation should normally be performed in the design or drawing models when using the Named 
Boundary process to create sheets. 
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5.2 Attaching the Container file (or references) 
In the following steps, will create a file to reference the container file.  In subsequent sub-
sections we will place Named Boundaries and then create 1”=50’ Plan & Profile Sheets along 
alignment CR44.  We will then create separate Plan & Profile sheets in Sections 6 & 7 along US85 
@ a scale of 1”=100’.  If you had the same scale for all sheets, you could ultimately create one file 
for the Named Boundaries but that’s not the case here so we are specifying CR44 in the name of 
the file as shown in step 1 below. 

 
1) Create and enter the file 12345_RD_Plan Profiles_CR44.dgn (Using a 2D Seed file). 

 
2) Reference the file 12345_RD_Container for Plans.dgn with the following settings. 

 
 
NOTES: 

• Nesting depth of 1 will bring all the references in the Container file. 
• Display Overrides is set to Never. 
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3) Fit the view which should appear as shown below.  
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5.3 Placing Plan Named Boundaries 
 

1) Select the Drawing Production ribbon tab, confirm or set a scale of 1”=50’, then select Named 
Boundary from the Drawing Production ribbon tab.   
 

 
 

2) On the Place Named Boundary dialog:  
a) Choose the Civil Plan icon at the top of the dialog,  
b) Choose the Plan-Profile – 50 Scale – 5x Vert. Exag. - PLAN Drawing Seed  

The following are the available Plan-Profile Drawing Seeds you can choose from.   

 
c) Select alignment CR44 (You are being prompted to Identify Path Element in the 

lower left of the MicroStation view.  You may have to Right click to select this 
element because there is a Template produced CL element on top or below CR44.) 

d) Uncheck the Create Drawing checkbox at the bottom of the dialog (if necessary).  
  

NOTE:  Create Drawing performs the model/sheet creation which we are not ready to 
do until we have placed named boundaries for both plan and profile.   
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The dialog should look as shown below following the 4 steps.  
 

   
 

NOTE:  Although we will not make changes in this class, observe the two Name fields in the 
dialog above.  The 1st (Plan 1) represents the name of the named boundaries.  The 2nd (CR44) is 
the Group the named boundaries will fall under which should be the alignment name.  The 
software will join these two “Names” when creating drawing and sheet models.   

 
3) You should be prompted to Identify Path Start Point to Place Boundary.  Move your cursor and 

notice the graphics which indicates the start Location. 

   
NOTES:   

• You can set this Start Location with a data point, key-in, or lock the start station 
to the beginning of the alignment by clicking the lock to start button  . 

• You can key-in numbers less than the starting station of the alignment to 
place the Named Boundary prior to the start station.   
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4) As mentioned in the note above, you can key-in numbers less than the starting station of the 
alignment so for this example, key-in -25 

 
 

5) Data Point to confirm the Start Station which previews the 1st named boundary and ultimately 
more as you move your cursor down the alignment.   

 
 

 
6) Now you are prompted to identify the end location to place the boundary.  Move your cursor 

towards the end of the alignment.  Data Point so the last sheet is placed as shown below.    
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7) Make changes to Offsets and Boundary chords if needed at this point although we will not make 
any changes in this example.   

 
 
NOTE:  Boundary Chords set to 0 will place a rectangular shape.  If set to 10 or 20, the Named 
Boundaries will be curved around curves.  The Boundary Chords introduced can be moved as 
needed to adjust the clipping area. 
 

8) Data Point one more time to accept the Named Boundary Placement.  This will exit you out of 
the Place Named Boundary dialog.   

 
9) Turn any other plan view levels off as needed and Save Settings.  In this example, turn 

construction class off to turn the corridor handlers off. 
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5.4 Placing Profile Named Boundaries 
1) Set the referenced Terrain Active. 

 
2) Open the References dialog and turn OFF display of the CDOT Default-3D model of the 

reference file 12345_RD-Plan Profiles_CR44.dgn. 

 
 
3) Open the profile model of US85_NB in View 7 
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4) Invoke the Named Boundary dialog and choose the Civil Profile mode and set the Drawing Seed 
to Plan-Profile -50 Scale – 5x Vert. Exag. - PROFILE 
 

  
 
NOTE: Below are the Plan-Profile (PROFILE) Drawing Seeds available. 

 
 

5) Set the Method to From Plan Group, The Vert Exageration 5, check Use Terrains and Use 
Active Vertical.  The dialog at this point should look similar to what is shown below, making 
note that Create Drawing is set:   

 

NOTES:   
• You do have the option of checking the 

Create Drawing checkbox which means 
when you confirm all the prompts, you 
will move straight into the Create 
Drawing dialog.  We will not in this 
example but this is a viable option. 
 

• Give 1”=50’ Horizontal & Vertical 
Exaggeration of 5.  To calculate the 
Vertical scale:  50/5 = 10 so the Vertical 
Scale will be equal to 1”=10’. 
 

• Make note of the Available Profile Height 
(50 in this example).  This will help you 
choose which Profile Annotation Group 
you will use.   
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6) Once prompted to Identify Profile View, data point in View 7 which should be still opened as a 
profile view. You should then be able to view the named boundaries in the profile view. 
 

 
NOTE:  

• The number of Profile Named boundaries matches the Plan Names 
boundaries but that may not be the case when there is a lot of vertical 
change along the profile.  If the profile will not fit on a profile named 
boundary, the software will break that named boundary into 2 or more 
named boundaries and shift the vertical datum so that it is different for 
each extra named boundary if Profile Shifts is set to Datum Stations as 
shown below. 

 
 

7) Data point to accept the placement of the named boundaries. 
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5.4.1 Displaying Elements on Profiles 

Profiles, unlike cross-sections, do not automatically display every 3D element the alignment 
cuts across.  However, the Create 3D Cut tool will add any elements the alignment cuts across 
to the profile.  We will demonstrate how to display items on profiles that cross alignments (like 
cross drains or other corridors) in the next few steps with this command.  These steps can be 
perfromed after sheet setup and any elements added to the profiles should automatically show 
on the profile drawing model and sheet model.   
 

1) Open 12345_RD_Geometry.dgn 
 

2) Reference the 12345_RD_Drainage.dgnfile.   
 

3) Open the profile model of alignment CR44. 
 

 
 

4) Turn OFF display of the 12345_SV_Topo.dgn file in the Defaul-3D model.   
 

5) Select the command Create 3D Cut from the top of the Profile View.  
 

 
 

6) Set the Placement method to Full Profile and then data point to create the 3D cut.   

 
 

7) Review the profile and you should see the cross-drain we placed in the previous section.   
 

 
  



PLAN/PROFILE SHEET CREATION  Modifying Named Boundary Locations & arranging 
Text  

                                     47  
               

5.5 Modifying Named Boundary Locations & arranging Text 
Before you go through the process of creating sheets, you may need to move the named 
boundaries to encompass important data on the sheet that may not be initially covered.  For 
plan named boundaries, you can use MicroStation’s Move tool to simply move the plan named 
boundary.  For profile named boundaries, there is an Adjust Profile Named Boundary tool 
available in the Named Boundary pulldown menu that would need to be used.   
 

1) Select the 1st named boundary and move it to the North just a little.   
 

 
 

2) Move the curve data that is at the bottom of named boundaries 1 & 2 so that it is in the middle 
of named boundary 1.  Since the curve data is in a reference, hold down the Reset button on 
the curve data, choose Activate, select Geometry_Annotation.dgn.   
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3) Move & rotate the curve data so that it is positioned on named boundary 2 as shown below.   

 
4) Perform the same process (make sure all other curve data fits on for all other CR44 Curve data.  
5) Hold down your right mouse button and choose Deactivate Default to return to 

12345_RD_Plan Profiles_CR44.dgn.  

 
 

6) Next, we will move a named boundary in the profile view by selecting the Adjust Profile Named 
Boundary command from the Named Boundary pulldown.   

 
 

7) You are prompted to Identify the Profile View.  Data point in View 7 which should still be open 
as the profile view for ML_SR4. 
 

8) Select the 1st named boundary (middle shape below) and move it to elevation 445.   
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5.6 Creating Sheets (Named Boundary Manager) 
In the next few steps we will create sheets from the named boundaries we have placed.  The 
Profile View must remain open through this process when creating Plan & Profile sheets.   

1) Turn off any levels you do not want on your sheets, turn off construction class elements, and 
then Save Settings.  This can be performed later as well and controlling sheet levels is discussed 
more in section 7.6   
 

2) Select the Manage Named Boundaries button. 

 
 

3) The Named Boundaries dialog is invoked.  Expand the Plan Groups & Profile Groups to review 
the named boundaries & select CR44 under the Plan Group.   

 
 
 

NOTE:    
• If there are no arrows next to Plan Groups & Profile Groups, exit the dialog & 

open it again which should clear up that issue. 
• In this dialog, you can delete Named Boundaries, go to Properties and rename 

named boundaries, create Plan & Profile sheets, etc.   
 

  



PLAN/PROFILE SHEET CREATION  Creating Sheets (Named Boundary Manager)  

                                     50  
               

4) Select CR44 under Plan Groups and choose the Show Create Drawing button.  

 
 

5) With CR44 still selected, choose the Create plan/profile drawing button. 
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6) This invokes the Create Drawing dialog which is shown below step 7.  The Plan view type is on 
the left and the Profile view type is on the right side of the dialog.  You generally do not have to 
change much on this dialog unless you are working with a different scale (which is discussed 
later in this section).   

7) Change the Profile Annotation Group from Profile Grid 100ft Spacing to Profile Grid 10ft 
Spacing.  Remember our maximum Available Profile Height was 50 on the Named Boundary 
dialog.  Using this annotation group will give us 10ft annotations for the elevation datum.   

 
NOTES:   
• You cannot create plan & profile sheets if the profile view is not open. 
• The 1st check box on this dialog will create one DGN file per sheet if you check it.  If 

you do check it, the name of the DGN’s created comes from the Sheet Model Name. 
• It’s your preference but we will leave Add to Sheet Index box unchecked. 

Files/Sheets can be added to Sheet Index later if needed.  If you decide to check 
this, choose the icon to the right to specify the folder name. 

• The Profile Annotation Group is what places the profile grid, annotates the 
elevation datum, station datum, and any proposed profile that is present when the 
drawings models are created.  

  



PLAN/PROFILE SHEET CREATION  Creating Sheets (Named Boundary Manager)  

                                     52  
               

8) Tag OK to generate sheets.  A status bar is displayed in the lower right of the MicroStation 
window showing progress until the sheets are created.  When the processing is complete, you 
should be moved to the model of the last sheet created. 
 

 
9) Open the MicroStation models dialog (Home ribbon tab -> Primary ribbon group) and review 

the models created. 

 
NOTES:  
• There are 3 models created for each plan & profile sheet: 

a) Plan – Drawing model 
b) Profile – Drawing model 
c) Plan 1 (Sheet) – Sheet model 

• You can select and delete all Drawing/Sheet models if there is a need to re-create 
sheets (Compress and exit before re-processing though.) 
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10) Close the Models dialog and at the bottom of the MicroStation view, review the Active View 
Groups.  Open a Plan View, a Profile view & other Sheets and then return to the Plan 6 sheet. 
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6. SHEET & NAMED BOUNDARY MANAGEMENT 

6.1 Section Overview 
This section covers Sheet & Named Boundary related tasks outside the normal creation process 
such as deleting Sheets & Named Boundaries, managing level and reference display, modifying 
sheet reference clipping & location, etc.   

6.2 Deleting Sheets & Named Boundaries 
If sheets need to be re-created, delete all drawing and sheet models prior to re-creating.  If the 
named boundaries need to be deleted and placed again, go to the Named Boundary Manager 
and delete the Named Boundaries.  Compress the file, exit, and then re-enter the file before 
creating named boundaries again.  This sequence purges the Named Boundary names so they 
can be re-used. 
 
For the sheets just in the last exercise, there doesn’t appear to be enough room for the plan 
area on some of the sheets as shown below (on sheet 6).  We will delete all the sheet related 
models and profile named boundaries and recreate the sheets in the following steps.  

 
 

1) Return to the Multi-Model views. 
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2) Open the Models dialog, select all sheet related models (All models except CDOT Default & 
CDOT Defaul-3D), and then delete the selected models. 

 
 

3) Open the Named Boundaries dialog and delete the Profile Named Boundaries. 

 
4) Choose File-> Tools -> Compress File 
5) Choose File -> 12345_RD_Plan_Profiles_CR44.dgn to close & re-open the file.  
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6.3 Modifying Default Drawing Seed Settings 
Drawings Seeds set the default values on the Place Named Boundary dialog.  These values do not 
normally have to be changed but they can.  In this example, we will replace the Profile Named 
Boundaries that we just deleted and will change the Default Profile Height to give us a little more 
space for the Plan View.  We will go through more examples of this in the Roll Plots Section.   
 

1) Let’s place Profile Named Boundaries again so select Named Boundary from the Drawing 
Production ribbon tab.  The settings you should use are shown below.  We previously used a 
Vertical Exaggeration of 5 which gave us an Available Profile Height of 50.  Leave the Vertical 
Exaggeration set to 5 but change the Available Profile Height to 40.   
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2) Move the last two Named Boundaries up if needed to elevation 4710 with the Adjust Profile 
Named Boundary dialog. 

 
 

3) Open the Named Boundary dialog and go through the sheet creation process.  

 
4) Change the Profile Annotation Group to Profile Grid 10ft Spacing on the Create Drawing dialog 

and then choose OK to recreate the sheets. 
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5) Review the change on Sheet 6 -> We have more room for the Plan View. 
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6.4 Modifying Sheet References 
We will discuss moving sheet references and changing the clipping shape in this section.  
 

1) Open sheet 5.  Notice the Plan area really needs to be shifted down on the sheet.   

 
2) Open the References dialog, choose the Plan reference, right click it, & then choose Move. 
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3) Data Point for the location to move from and then datapoint for the location to move to.  

 
4) We want to see more of the survey on the South side of this intersection (the area shaded blue 

below). 

 
 

5) Open the Multi-Model View group and turn Construction class on in View 1 if it is not on.   
6) Choose the Delete Vertex tool.  
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7) Delete all the Vertex’s on the South side of the Named Boundary. 
BEFORE: 

 
AFTER: 

 
AFTER SHOWING VPI’s: 
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8) Return to Plan Sheet 5 and review the Plan View which should look similar to the image below.  

 

6.5 Adding Reference Files 
To add reference files to previously created Plan and Profile Sheets, follow the steps below: 
 

1) Open the Default model.  
 

2) Invoke MicroStation’s Reference Dialog, attach the needed references, and the references 
should show up on the drawing and sheet models.    
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6.6 Controlling Sheet Levels 
A new reference setting now allows level control for all sheet models. Turning off unwanted 
levels in the Default model will display the same on all sheet models. This is controlled by the 
Synchronize View setting in the reference properties of each Drawing model. 
 

1) Go to a Plan Drawing model. 
2) Open the Reference dialog.  
3) Double click the reference file.  
4) Review the Synchronize View setting below.  

 

  
 

5) Open the Plan 1 Sheet model 
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6) Observe the terrain model on this sheet.  This should not be displayed.   

 
7) Open the Default or Multi Model Named views. 

 

 
 

8) Make View 1 the Active View by data pointing on the top of that view.  
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9) Hover over the Terrain model, hold down your right mouse button and from the Reset menu,  
choose Level Off. 

 

 
 

 
10) Choose Save Settings and return to the Plan 1 Drawing and Sheet models and make sure this 

level is off there to verify the Synchronize View setting is working. 
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6.7 Other Scale Sheets 
Drawing Seeds are set up for many different scales but should you need a Drawing Seed with a 
scale that isn’t available, the steps below describe the scale changes you need to make during 
the Named Boundary process to create sheets at other scales.   At this time, for example, there 
is not a Plan Profile Sheet Seed for a 1”=20’ scale.  If you needed a 1”=20’ Plan & Profile Scale & 
a 1”=5’ Vertical scale, you would set the scales in the following locations.  
 

1) Drawing Scale of on the Drawing Production Ribbon Tab 

 
 

2) Detail Scale of the Plan Named Boundaries.  Note that when the Detail Scale is changed, other 
values such as Length and Offsets are adjusted automatically. 
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3) Detail Scale and Vertical Exaggeration of the Profiled Named Boundaries 

 
 

NOTE:   In the example above, a Vertical Exaggeration of 4 (20/4) would give you 1”=5’ 
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4) Annotation Scale of the Drawing Models created during the Create Drawing process.   
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7. PLAN SHEETS (along Alignment) 

7.1 Section Overview 
This section will cover creation of Plan sheets along an alignment.    We will generate one set of 
Plan Named Boundaries & sheets for US85 at a scale of 1”=100’.  In the next section, we will 
generate Profile Sheets for US85 SB & NB. 

Annotation should normally be performed in the design or drawing models when using the 
Named Boundary process to create sheets. 

7.2 Attaching the Container file (or references) 
In the following steps, will create a file to reference the container file.  In subsequent sub-
sections we will place Named Boundaries and then create 1”=100’ Plan along US85.  If you had 
the same scale for all sheets, you could ultimately create one file for the Named Boundaries but 
that’s not the case here so we are specifying CR44 in the name of the file as shown in step 1 
below. 

1) Create and enter the file 12345_RD_Plan Profiles_US85.dgn (Using a 2D Seed file). 
2) Reference the file 12345_RD_Container for Plans.dgn with the following settings. 

 
 
NOTES: 

• Nesting depth of 1 will bring all the references in the Container file. 
• Display Overrides is set to Never. 



PLAN SHEETS (along Alignment)  Attaching the Container file (or references)  

                                     70  
               

3) Fit the view which should appear as shown below.  
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7.3 Placing Plan Named Boundaries 
 

1) Select the Drawing Production ribbon tab, confirm or set a scale of 1”=100’, then select Named 
Boundary from the Drawing Production ribbon tab.   
 

 
 

2) On the Place Named Boundary dialog:  
a) Choose the Civil Plan icon at the top of the dialog,  
b) Choose the Plan – 100 Scale Drawing Seed  

NOTE: Below is a list of the available Plan Drawing Seeds you can choose from.  Plan 
Profile Drawing Seeds are omitted from this list.  

 
c) Select alignment US85-NB (You are being prompted to Identify Path Element in the 

lower left of the MicroStation view.  You may have to Right click to select this 
element because there is a Template produced CL element on top or below US85-
NB.) 
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d) Uncheck the Create Drawing checkbox at the bottom of the dialog (if necessary).  
NOTE:  Create Drawing performs the model/sheet creation which we are not ready to 

do until we have placed named boundaries for both plan and profile.   
 The dialog should look as shown below following the 4 steps.  

 

 
 

NOTE:  Although we will not make changes in this class, observe the two Name fields in the 
dialog above.  The 1st (Plan 1) represents the name of the named boundaries.  The 2nd (CR44) is 
the Group the named boundaries will fall under which should be the alignment name.  The 
software will join these two “Names” when creating drawing and sheet models.   
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3) You should be prompted to Identify Path Start Point to Place Boundary.  Move your cursor and 
notice the graphics which indicates the start Location. 

   
NOTES:   

• You can set this Start Location with a data point, key-in, or lock the start station 
to the beginning of the alignment by clicking the lock to start button  . 

• You can key-in numbers less than the alignment to place the Named 
Boundary prior to the start station.   
 

4) For this example, key-in 997+00 (which is 90’ beyond the Start of the alignment.) 

 
 

5) Data Point to confirm the Start Station which previews the 1st named boundary and ultimately 
more as you move your cursor down the alignment.   
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6) Now you are prompted to identify the end location to place the boundary.  Move your cursor 
towards the end of the alignment.  Data Point so the last sheet is placed as shown below.    

  
7) Make changes to Offsets and Boundary chords if needed at this point although we will not make 

any changes in this example.   

 
 
NOTE:  Boundary Chords set to 0 will place a rectangular shape.  If set to 10 or 20, the Named 
Boundaries will be curved around curves.  The Boundary Chords introduced can be moved as 
needed to adjust the clipping area. 
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8) Data Point one more time to accept the Named Boundary Placement.  This will exit you out of 
the Place Named Boundary dialog.   

 
9) At this point, you would review each Named Boundary and referenced elements and ensure 

everything that needs to be displayed on each Named Boundary is present.  This is the stage 
where you could move Named Boundaries or Activate or Exchange References and move or 
rotate text so it is displayed on the Named Boundray.  Also, you would turn any plan view levels 
off as needed and Save Settings.   

 
In this example, turn construction class off to turn the corridor handlers off and Save Settings.  
The Plan Named Boundaries are also on Construction class so they will be turned off as well.   

7.4 Creating Sheets (Named Boundary Manager) 
In the next few steps we will create sheets from the named boundaries we have placed.  Turn 
off any levels you do not want on your sheets, turn off construction class elements, and then 
Save Settings.  This can be performed later as well and controlling sheet levels is discussed more 
in section 7.6   
 

1) Select the Manage Named Boundaries button. 

 
 

2) The Named Boundaries dialog is invoked.  Expand the Plan Groups & Profile Groups to review 
the named boundaries & select US85-NB under the Plan Group.   

 
 
 

NOTE:    
• If there are no arrows next to Plan Groups & Profile Groups, exit the dialog & 

open it again which should clear up that issue. 
• In this dialog, you can delete Named Boundaries, go to Properties and rename 

named boundaries, create Plan & Profile sheets, etc.   
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3) Select US85-NB under Plan Groups and choose the Show Create Drawing button.  

 
 

4) With US85-NB still selected, choose the Create plan/profile drawing button. 
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5) This invokes the Create Drawing dialog which is shown below.  You generally do not have to 
change much on this dialog unless you are working with a different scale (which is discussed 
later in this section).   

 
NOTES:   
• The 1st check box on this dialog will create one DGN file per sheet if you check it.  If 

you do check it, the name of the DGN’s created comes from the Sheet Model Name. 
• It’s your preference but we will leave Add to Sheet Index box unchecked. 

Files/Sheets can be added to Sheet Index later if needed.  If you decide to check 
this, choose the icon to the right to specify the folder name. 
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6) Tag OK to generate sheets.  A status bar is displayed in the lower right of the MicroStation 
window showing progress until the sheets are created.  When the processing is complete, you 
should be moved to the model of the last sheet created. 
 

 
7) Open the MicroStation models dialog (Home ribbon tab -> Primary ribbon group) and review 

the models created. 

 
 

NOTES:  
• There are 2 models created for each plan sheet: 

a) Plan 1 – Drawing model 
b) Plan 1 (Sheet) – Sheet model 

• You can select and delete all Drawing/Sheet models if there is a need to re-create 
sheets (Compress and exit before re-processing though.) 
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8) Close the Models dialog and at the bottom of the MicroStation view, review the Active View 
Groups.  Open some of your Plan Views & Plan [Sheets] Views and then return to the Plan 6 
sheet. 

 
 

9) Move back to the Default view & Save Settings.  
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7.5 Roll Plots  
Roll plots are sheets longer than the normal sheet and normally show the entire project or at least 
longer sections of the project.  These are generally used for public hearings or presentations.  The 
following Roll Plot Drawing Seeds are available.  

 
 
Below is an example of a Roll Plot. 
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8. PROFILE SHEETS 

8.1 Section Overview 
Profile Only Sheet creation is discussed in this section.  We will continue working in 
12345_RD_Plan Profiles_US85.dgn. 

Annotation should normally be performed in the design or drawing models when using the 
Named Boundary process to create sheets. 

8.2 Placing Profile Named Boundaries 
1) Open the Default model in View 1. 
2) Set the referenced Terrain Active. 

 
 
3) Open the References dialog and turn OFF display of the CDOT Default-3D model of the 

reference file 12345_RD-Plan Profiles_US85.dgn. 
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4) Open the profile model of US85_NB in View 7 

 
 

5) Invoke the Named Boundary dialog and choose the Civil Profile mode and set the Drawing Seed 
to  Double Profile - 100 Scale – 10x Vert. Exag.  
 

  
 
NOTE: Below are the available Profile Drawing Seeds.  The Plan & Profile (PROFILE) ones are 
omitted from this list. 
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6) Set the Method to From Plan Group, The Vert Exaggeration 10, check Use Terrains and Use 
Active Vertical.  The dialog at this point should look similar to what is shown below, making 
note that Create Drawing is set:   

 

 
NOTES:   
• You do have the option of checking the Create Drawing checkbox which means 

when you confirm all the prompts, you will move straight into the Create Drawing 
dialog.  We will not in this example but this is a viable option. 

• Given 1”=100’ Horizontal & Vertical Exaggeration of 10.  To calculate the Vertical 
scale:  100/10 = 10 so the Vertical Scale will be equal to 1”=10’. 

• Make note of the Available Profile Height (40 in this example).  This will help you 
choose which Profile Annotation Group you will use.   
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7) Once prompted to Identify Profile View, data point in View 7 which should be still opened as a 
profile view. You should then be able to view the named boundaries in the profile view. 
 

 
NOTE:  

• The number of Profile Named boundaries matches the Plan Names 
boundaries but that may not be the case when there is a lot of vertical 
change along the profile.  If the profile will not fit on a profile named 
boundary, the software will break that named boundary into 2 or more 
named boundaries and shift the vertical datum so that it is different for 
each extra named boundary if Profile Shifts is set to Datum Stations as 
shown below. 

 
 

8) Data point to accept the placement of the named boundaries. 
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8.3 Creating Sheets (Named Boundary Manager) 
In the next few steps we will create sheets from the named boundaries we have placed.  The 
Profile View must remain open through this process when creating Profile sheets.   
 

1) Select the Manage Named Boundaries button. 

 
 

2) The Named Boundaries dialog is invoked.  Expand the Profile Groups to review the named 
boundaries and follow steps1-3 on the image below.   

 
 
 

NOTE:    
• If there are no arrows next to Plan Groups & Profile Groups, exit the dialog & 

open it again which should clear up that issue. 
• In this dialog, you can delete Named Boundaries, go to Properties and rename 

named boundaries, create Plan & Profile sheets, etc.   
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3) This invokes the Create Drawing dialog which is shown below step 4.  You generally do not have 
to change much on this dialog unless you are working with a different scale (which is discussed 
later in this section).   

4) Change the Profile Annotation Group from Profile Grid 100ft Spacing to Profile Grid 10ft 
Spacing.  Remember our maximum Available Profile Height was 40 on the Named Boundary 
dialog.  Using this annotation group will give us 10ft annotations for the elevation datum.   

 
NOTES:   
• You cannot create profile sheets if the profile view is not open. 
• The 1st check box on this dialog will create one DGN file per sheet if you check it.  If 

you do check it, the name of the DGN’s created comes from the Sheet Model Name. 
• It’s your preference but we will leave Add to Sheet Index box unchecked. 

Files/Sheets can be added to Sheet Index later if needed.  If you decide to check 
this, choose the icon to the right to specify the folder name. 

• The Profile Annotation Group is what places the profile grid, annotates the 
elevation datum, station datum, and any proposed profile that is present when the 
drawings models are created.  
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5) Tag OK to generate sheets.  A status bar is displayed in the lower right of the MicroStation 
window showing progress until the sheets are created.  When the processing is complete, you 
should be moved to the model of the last sheet created. 
 

 
6) Open the MicroStation models dialog (Home ribbon tab -> Primary ribbon group) and review 

the models created which are highlighted in the image below. 

 
NOTES:  
• There are 2 models created for each profile sheet: 

a) Profile – Drawing model 
b) Profile 1 (Sheet) – Sheet model 

• You can select and delete all Drawing/Sheet models if there is a need to re-create 
sheets (Compress and exit before re-processing though.) 
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7) Close the Models dialog and at the bottom of the MicroStation view, review the Active View 

Groups.  Open a Plan View, a Profile view & other Sheets and then return to the Plan 6 sheet. 

 
 
NOTE: The Plan sheets present are the ones we created in Section 9. 
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9. CROSS SECTIONS 

9.1 Section Overview 
To generate cross-section sheets, cross section Named Boundaries are generated at proposed 
cross section locations, drawing models are then created from the named boundaries for each 
cross-section, and sheet models are then created based on how many drawing models can fit 
on a sheet.  This process will be discussed in this section along with cross section annotation 
and earthwork. 
 
A few items to keep in mind in regards to OpenRoads cross sections:  

• The cross section is a live slice of the 3D model so any changes to the corridor 
or terrain means the cross section is automatically updated.  

• Cross section annotation is not automatically updated so it has to be redone if 
the corridor changes. 

• The cross section drawing model and sheet models can be created at separate 
times.  This ability allows the user to add new sections as needed, create the 
drawing model only for these added sections, and then create new sheets for 
all sections which will allow these added sections to be included in the sheets in 
the correct order while allowing the existing drawing models which possibly 
have a lot of specific annotation to not have to be re-created. 

Note that cross section annotation should normally be performed in the cross section drawing 
models.   
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9.2 Attaching the Container file (or references) 
In the following steps, will create a file to reference the container file.  In subsequent sub-
sections we will place Named Boundaries and then create 1”=10’ cross-sections along CR44.  You 
can create one file for cross-sections or one file per alignment.   

1) Create and enter the file 12345_RD_XS_CR44.dgn (Using a 2D Seed file). 
 

2) Reference the file 12345_RD_Container for Plans.dgn with the following settings. 

 
 
NOTES: 

• Nesting depth of 1 will bring all the references in the Container file. 
• Display Overrides is set to Never. 
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3) Fit the view which should appear as shown below.  
 

 
 

4) Set the referenced Terrain Active. 
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5) Open the References dialog and turn OFF display of the CDOT Default-3D model of the 
reference file 12345_RD-Plan Profiles_CR44.dgn. 

 
 
6) Hold down your right mouse button and choose Views Plan/3D to open a 3D view.  This is 

required to place the named boundaries and create drawings fox cross sections. 
 

 
 
7) Save Settings 
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9.3 Creating Cross Section Sheets 

9.3.1 Overview  

Named Boundaries are created in the 3D view as shown below.  

 
Size of the cross section named boundaries are determined by the corridor and active terrain 
model plus settings on the Place Named Boundary tool.  Drawing models are generated for each 
cross section named boundary as shown below.  

 
 
Sheet models are created based on how many of the drawing model “windows” will fit on the 
sheet based on the “window” size plus cross section configuration variables that dictate the 
distance off the top/bottom the sheet, distance between sections, etc.  An example sheet and 
these configuration variables are shown below. 

 
The following are steps for using Named Boundaries to generate Cross-Section Sheets.   

 
 
Steps to place named boundaries and create the x-section drawing and sheet models is 
discussed below. 
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9.3.2 Event Points  

The next section describes the Named Boundary process to place cross-section named 
boundaries along an alignment at a station interval (and control points if so desired).  There are 
a couple of methods available to add cross-section named boundaries at user defined locations 
(such as drives, cross-drains, etc.) that are not at an interval or control point.   The ideal method 
for additional cross-sections @ 90 degree angle to the baseline is using Event Points.  
 

1) Open 12345_RD_Geometry.DGN. 
 

2) From the Geometry ribbon tab, choose the Event Point List command from Common Tools. 

 
 

3) Choose the Alignment CR44 when prompted to Locate Alignment. 
 

4) Confirm No on the next two prompts. 
 

 
 

5) The Event Point List dialog is invoked. 
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6) Choose the Rename List command and rename it to XS-CR44. 

 
 

 
 
 

7) Select the Add By Station Offset command.  

 
 

8) Snap to the CL of Drive around 25+12 on CR44.
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9) Confirm the station/offset of 0 with a datapoint and the Event Point is added to the list.  

 
 

10) Go through steps 7-9 again continue to add the other driveway around station 36+33.  The 
dialog should appear as shown below.  
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9.3.3 Placing Named Boundaries 

1) Return to 12345_RD_XS_CR44.dgn 
 

2) Select Named Boundary from the Drawing Production ribbon tab.   
 

 
 

3) On the Place Named Boundary dialog, select the Civil Cross Section mode and select 20H 10V 
for the Drawing Seed.  
 

 

NOTES: 
• Below is a list of Cross Section Drawing Seeds 

available. 

 

H= Horizontal 
Scale, V=Vertical 
scale 

 

We will discuss more setting on this dialog a 
few steps further down.   
 

 
4) Observe in the lower left MicroStation window.  You are being prompted with the following:   
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5) Select the CR44 alignment. 
 

 
 

6) Next, you are being prompted the following.   
 

 
 

7) Move your cursor and notice the graphics which indicates the Start Location. 
 

   
 

NOTE:  You can set this Start Location with a data point, key-in, or lock the start station 
to the beginning of the alignment by clicking the lock to start button  . 
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8) For this example, choose Lock to Start & Lock to End. 
 

 
 

9) You should see the named boundaries in the 2d view as shown below.  
 

 
 

10) Choose the Event Point List at the bottom of the dialog we previously created (XS-CR44)  Also, 
uncheck Create Drawing & set the Interval to 100.  The dialog should be set as follows. 

 

 

NOTES: 
• Observe the Vertical Exaggeration of 2.   This is 

what gives you the 10 Vertical scale when 
using the 20H 10V drawing seed.  If you set the 
Vertical scale to 1 when using the 20H 10V 
drawing seed, you would actually get a 20H 
20V scale. 

• Left & Right Offset – Controls the width of the 
cross-section. 

• Top Clearance – The Top and Bottom 
clearance add extra 'space' to the cross section 
- by default, the 'window' around the section 
would be the minimum necessary to show the 
section.  Giving clearance values moves the top 
of the 'window' up (and the bottom down) so 
that you have a bigger view.  

• Include Control Points - Will add cross sections 
at all horizontal & vertical critical points such 
as PC’s, PT’s, low points, etc.   

 
 
 

11) Data Point to confirm the Start Station & End Station.   
 

12) Data Point one more time to accept the Named Boundary Placement.   
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13) The named boundary dialog will close and the named boundaries will be placed and should be 
visible to you in the 3D view.  They will also be visible in the 2D view if the Default-3D model 
display is on.  Below is an image of the XS Named Boundaries.  Also, notice the Named 
Boundary with the arrow pointing at it below.  This Named Boundary was placed at one of the 
Event Points designated earlier.   

 
 

NOTES:  
• Any 3D element that cuts through this cross-section named boundary will be 

displayed on cross-sections once they have been generated.   
• It’s a best practice to Use the Corridors -> Review -> Dynamic Sections dialog to 

quickly review cross-sections to ensure that everything that needs to be shown 
on the cross-sections (Drainage, full template, terrain, etc.), will show up in the 
XS Named Boundary window which you can see in the cross-section view as 
long as the Start Station and interval matches what was used when placing the 
Named Boundaries.  See the example below.  

 
 
If there are elements that do not fit on the XS, you may want to delete the 
Named Boundaries & place them again making as-needed adjustments (scale, 
offsets, Top & Bottom clearance, etc. 
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9.3.4 Creating Sheets 

1) After placing all the additional Named Boundaries needed, invoke the Managed Named 
Boundaries as shown below: 
 

 
 

2) Expand the Cross Section Group and choose CR44.  
 

 
 

3) Choose the Show Create Drawing dialog button at the top of the dialog.   
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4) Choose the Create Cross Section Drawing button at the top of the dialog.  

 
 

NOTE:  
• You also have the option to right click the Cross Section group and choose Create 

Cross Section Sheets from Drawings which will not create the Drawing models.  
This is ideal for using in a workflow where additional x-sections have been added 
(as described in the Notes of the next step) and all sheets are being re-created from 
the Drawing models.  
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5) The resulting Create Drawing dialog is shown below. Choose OK to create cross-section sheets. 

 
NOTES:   
• You can make changes here but none may be necessary.   
• Annotation Group – The initial annotation group used draws the XS Grid, annotates 

slopes, and uses the inline offset annotation with no flags.  Go to the 
ANNOTATION\XS Annotation section to see more discussion on the different 
annotation groups available.   

• Pay close attention to the Check Box under Sheet Model on the Create Drawing 
dialog.  If not checked, the Drawing models will be created but the Sheet models 
would not be created.  If you needed to add additional x-sections to already created 
x-section drawing & sheet models, you can uncheck this and not create the Sheets.  
You could then delete all the Sheet models and re-cut all sheets with the new x-
section added in order by using the right click -> Create Cross Section Sheets from 
Drawings.   
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6) Click OK to create the cross-section sheets.   
 

7) Observe the status bar in the lower right corner that shows the progress. 

 
8)   After processing, the last sheet model created should be opened.   

  
 

9) Open the Models dialog and review the cross section drawing and sheet models created.  A 
Drawing model is created for each station and sheet models are created based on how many 
cross-sections can fit on a sheet. 
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10) Close the model dialog and open the Active View Group which should be docked at the bottom 
of the MicroStation window.   

 
 

11) Open the 20+00 (Sheet) & 20+00 Drawing model.   

 
 
NOTE: At this point, sheets should be reviewed to ensure things like LT/RT Offset and 
Top/Bottom Clearance are adequate to show everything needed on the cross-sections.  If this is 
not the case, you would generally delete sheets at this point, replace the named boundaries in 
question with modified depth, width, and/or height, & then re-cut sheets when needed.  We 
will go through a few of these steps in the sections below.   
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9.3.5 Deleting Sheets & Named Boundaries 

We will go through the process of deleting all the sheets and some of the named boundaries in 
the next few steps.   Do note that the NOTES in steps 4 & 5 of the proceeding section discuss 
adding additional x-section drawing models, deleting sheets, and re-creating sheets.   
 
In our example & in the steps below, we plan on shifting the Offsets at the beginning of CR44 to 
show more of the right side of the roadway so that work removing the existing CR44 road can 
be shown.   

9.3.5.1 Deleting Sheets 
1) Open the Models dialog, select all the cross section sheet models, and choose Delete Models. 

 
2) Also, delete the Drawing models for cross sections 0+00 to 14+00 because we will 

replace these with different dimensions in the next section.   
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NOTE that we could have deleted all the drawing models as well and just recreated 
them all but having this ability to just add new named boundaries without deleting all 
the existing is needed when you have spent a lot of time annotating cross sections and 
you don’t want to delete them all.   

9.3.5.2 Deleting Named Boundaries 
1) Open the Named Boundary Manager, select, and then delete Named Boundaries 0+00 to 

14+00. 

 
 
NOTE:  You may be prompted with the following dialog.  Choose Yes To All. 

 
 
 
 
 
 
 
 
 
 
 

 
2) Go to File (the backstage area) and choose Tools -> Compress File.   

 
In the next section, we will add these Named Boundaries back but with different offsets. 
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9.3.6 Modifying Named Boundaries 

XS Named Boundaries can be modified in the 3D view but it is awkward to do this and the 
annotation doesn’t recognize the modified Named Boundary which is a pretty major issue.  A 
best practice is to:  

• Delete the Drawing model(s) & the Named Boundary(s) you need to modify (As we just 
performed in the previous section).  

• Use the Named Boundary tool to place the Named Boundary(s) again modifying the 
LT/RT offsets and or Bottom/Top clearance as needed. Make sure you choose the 
Group previously created instead of creating a new one.  (As we will do in the next few 
steps). 

1) Open the Named Boundary tool, select the cross-section mode, set the 20H 10V Drawing Seed, 
and choose the CR44 alignment.   Then set the dialog as shown below.  

 
 
NOTE: One big change here is changing the Group from New to CR44 which means the Named 
Boundaries about to be placed will be added to the CR44 group that already exists instead of a 
new group being created.  You normally want all the Named Boundaries for one alignment in 
the same Named Boundary group.   
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2)  Confirm the remaining prompts and the revised Named Boundaries at the beginning of the 
project are placed.  

 
 

3) Invoke the Managed Named Boundaries as shown below: 
 

 
 

3) Choose the Show Create Drawing dialog button at the top of the dialog.   
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4) Expand CR44 to ensure the added Named Boundaries are displayed. Select 0+00 to 14+00, right 
click, and choose Create cross section drawings.   

 
4) Uncheck Create Sheet Model and then click OK to regenerate just the drawing models for 0+00 

to 14+00.   
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5) Reopen the Multi-Model view and on the Named Boundary manager dialog, right click CR44 and 
choose Create Cross Section Sheets from Drawings. 

 
 

6) You are then prompted the following dialog.  Choose OK to create just the sheet models.  

 
 

 
• NOTE that you can write to previously created sheets by choosing the Sheet instead of 

having Sheets set to (New) if you were just going through this process for one or two 
sections. 
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9.3.7 Cross-Section Navigator 

1) Return to the Multi-Model View. 

 
 

2) Make sure you have both the Default & Default-3D models open. 
 

3) Select the Cross Section Navigator. 

 
 

4) Select your alignment. 

 
5) Open & then Data Point in View 6 when prompted to Select or Open View.   
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6) The view should display a cross section drawing model (0+00 below) and Cross Section 
Navigator is opened.  Use the tool to view other cross sections.  

 

 
 

NOTE: You can annotate in the view that is displaying the cross section. 
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9.3.8 Skewed X-Sections 

We will go through the process of creating Skewed X-Sections in this section.  We will create a couple of 
Drainage X-Sections along CR44 but we will put these in a different named Name Boundary group and 
ultimately create a separate sheet for the drainage x-sections so these drainage x-sections will not be 
mixed in order with the x-sections already cut. 
 

1) Open the Multi-Model View. 

 
 

2) Set View 1 as the Active view and attach the file 12345_RD_Drainage.dgn 

3) There are two cross-drains at the areas below.  

 
4) Zoom into the East most cross-drain (around 17+30) & invoke the Named Boundary tool.  
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5) Choose the Cross-Section 2 Point tool, set the Drawing Seed to 20H 10V, identify CR44 while 
being prompted to Identify Path Element, and set the name to CR44_Drainage. 

 
NOTE: You can choose the previously created Group instead of having this set to (New) if you 
wish to include these sections with a previously created group. 
 

6) Enter the 1st point on the Left side of CR44 and at the end of the Flared End Section and then 

enter the 2nd point on the Right side at the end of the Flared End Section. 

 
7) Data point to Accept the placement of the Named Boundary.   
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8) Perform the same process on the cross-drain @ 9+20.  Choose the CR44_Drainage Group 
instead of creating another New Group.  

 
9) Review the skewed Named Boundaries. 

 
10) Invoke the Named Boundary dialog. 
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11) Go through the steps below. 

 
12) Click OK on the Create Drawing dialog to create the X-Section Drawing & Sheet models. 

 
13) Review the Drainage XS. 
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9.4 Annotating Cross Sections 
Annotation of cross sections should be performed in the drawing model of the cross section.    
See the ANNOTATION section for cross-section annotation processes other than End Area 
Volumes which are discussed in the section below. 

9.5 End Area Volume Report 
If you want earthwork on cross-section sheets, you will need to process the End Area Volume 
Report in the file where cross-section named boundaries exist after Cut/Fill Volume elements 
have been created.  The steps below will take you through this process.   
 
Also, for earthwork to be annotated, the template must have the EAV Label template 
component (shown selected below) placed on the template (generally placed on the CL 
template point).   

 
 
1) Remaining in the files 12345_RD_XS_CR44.DGN and with View 1 the active view, reference the 

file 12345_RD_EW.DGN (This file contains the Cut/Fill Volume elements & you should see 
them in the 3D view once the reference is attached). 
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2) Select one of the Named Boundaries in View 2 (Default-3D mode) and review its Civil 

Properties in Element Properties.  Select the actual Station in Element Properties.   

 
Notice that there is no End Area Volume XML Fragment.  We will next run the End Area 
Volumes Report and the End Area Volume info will be added to this field. 

 
3) From the Home ribbon tab, select the Civil Analysis -> End Area Volume Report.   

 

 
 

4) Select the Named Boundary Group CR44 and confirm this Named Boundary with a data point. 
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5) You are prompted with the message below. We will choose Station 31+00 for the Start of a 

Volume Exception area and choose 33+00 for the End of the Volume Exception area & then 
Reset to process earthwork.  
 

  
 
 

6) Once complete, the End Area Volume report is generated.  Review this report. 
 

 
 

7) Close the report.  
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8) Select one of the Named Boundaries in View 2 (Default-3D mode) and review its Civil 
Properties in Element Properties again.  Select the actual Station in Element Properties.   

 
 
Notice that earthwork info has been added the End Ara Volune XML fragment field.  This is 
required prior to annotating cross-sections. 

 
9) Open the 25+00 XS Drawing model. 

 
 

10) From the Drawing Production ribbon tab, choose the Model Annotation command.  
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11) Select the XS End Area Volumes Annotation group.  

 
12) Check the All Drawing Models checkbox and then data point to confirm the prompts.   

 
 

13) Review the earthwork placed on the CR44 - 25+00 model and other models to see the 
earthwork.   
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As mentioned earlier, for earthwork to be annotated, the template must have the EAV Label 
template component (shown selected below) placed on the template (generally placed on the 
CL template point).   
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10. SUPERELEVATION DIAGRAM 
Below are steps to generate a sheet which displays a Superelevation Diagram in the profile view.  
Superelevation must have been calculated and applied to the corridor and referenced along with the 
corridor to the Named Boundary file.  You can create the super diagram when you set up sheets 
(Section 10.1 below) or through an annotation group to sheets already created (Section 10.2). 
 

10.1 Using a Drawing Seed 
The steps below will add a superelevation diagram to the Profile area when you set up Plan & Profile 
Sheets. 

10.1.1 Attaching the Container file (or references) 

1) Create and enter the file 12345_RD_SuperDIAGRAM-CR44.dgn (Using a 2D Seed file). 
 

2) Reference the file 12345_RD_Container for Plans.dgn with a Nesting Depth of 1 as 
described in Section 5.2 of this manual.  

 
3) Reference the file 12345_RD_Super-CR44.dgn. 

 
 

10.1.2 Placing Plan Named Boundaries 

1) Follow the steps in section 5.3 of this manual with the following exceptions. 
 
Set the following Drawing Seed and scale as shown below.  
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10.1.3 Placing Profiled Named Boundaries 

1) Follow the steps in section 5.4 of this manual with the following exceptions. 
Set the following Drawing Seed and scale as shown below.  

 

10.1.4 Creating Sheets 

1) Follow the steps in section 5.6 of this manual with the following exceptions 
Modify the scales designated below if needed and observe the Super Diagram Annotation Group.  
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2) You should be prompted with the following dialog.  Set the Targets and click OK.   

 
 

3) The sheets will process and you should be eventually moved into the last sheet model 
created.  Below is an example.  Make note of the Super diagram at the bottom of the 
profile.  
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10.2 Using an Annotation Group 
If you have Plan/Profile sheets already set up, you can add a superelevation diagram to the profile draw 
models using the steps below.   
 

1) Open the file that contains the Drawing/Sheet models and reference the superelevation to the file 
in addition to the corridor that has the superelevaton assigned. 
 

2) Open a Profile Drawing model and invoke the Drawing Model Annotation tool. 

 
3) Choose the Super Diagram annotation group as shown below.  
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4) Confirm All Drawing Models and then confirm the prompts to kick off the process.  

 
 

5) You should be prompted the following dialog.  Fill out the Targets and click OK.   

 
6) The Super diagram should be added @ the bottom of the profile area as shown below.  
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7) Move to a sheet model and then potentially move the profile drawing model references to fit the 
super on the sheet or potentially go back to the profile drawing model and move the super up 
there. 
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11. ANNOTATION 

11.1 Overview 
The Annotation tools available in OpenRoads Designer are found under the Drawing Production ribbon 
tab and are shown below.  

  
 

• Civil Labeler – Non-Feature based labeling that provides more of a manual placement of 
labels in the Plan, Profile, and XS design/drawing models.  Examples of the types of 
labels include Sta/Offset, Stat/Elevation, Offset/Elevation, Distance/Bearing, 
Intersection labels, Curve data, etc. 

• Element Annotation – Feature Based annotation used to annotate Alignments,  Survey 
elements, etc.   

• Drawing Model Annotation – This has to be ran in a Drawing model and is used to 
annotation items like: 

o Profile Grid, Datum, & Profile 
o Cross-Section Gird, Datum, Offset/Elevations, Slopes 
o ROW, Guardrail, etc. on Cross-Sections 

 
Most of OpenRoads annotation is automatically updated when changed and the file it resides in is 
opened.  A couple of examples of this automatic updating are; 

• If a curve in an alignment is changed, the Stationing & Curve data is automatically 
updated.  

• If a line whose distance/direction are labeled with Civil Labeler is modified, the 
length/bearing are update.   

The exception to this automatic update of annotation when the annotated element changes is cross-
section annotation.  Cross-Sections have to be re-annotated if the Corridor model changes. 
 

Annotation should normally be performed in the design or drawing models when the Named 
Boundary process has been used to create sheets. 

 
  



ANNOTATION  Civil Labeler  

                                     131  
               

11.2 Civil Labeler 

11.2.1 Overview 

The civil labeler is a production-focused annotation tool for the civil environment. Stored as part of a 
workspace, label definitions are easily shared while maintaining constancy and compliance with 
standards. Label definitions bring together Text Favorites, Text Styles, Dimension Styles, Element 
Templates, custom prompting, border frames, and lock settings into a single, repeatable label 
definition. In addition, civil labels can target multiple elements allowing more complex labels than other 
annotation tools. For example, the ability to target two geometry elements and compute offsets 
between geometry or interesting stations. 

 
 

3) Open 12345_RD_Plan Profiles_CR44.dgn 
4) Invoke Civil Labeler & expand the CDOT Civil Labels folder when the + sign appears next to it.  

(It takes a few seconds for the labels to load). 

 
5) Review the label types under each category.  
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6) Drive down into the Right of Way -> Linear folder and select the Bearing & Length label.  Review 
the dialog.  Observe the Place button on the various settings to the right of the dialog.   

 
 

11.2.2 Enable Label Manager 

In this section, we will show you how to create your own XML file to change/add label settings if you 
want.  This is not a requirement of use but an option only which will let you create or copy labels as 
needed.  You can see that the Civil Labeler looks at the CDOT_Civil Labeler.xml file that is in the 
workspace by default.  We will Save the XML within the project area in these steps. 

1) Choose the Enable Label Manager button in the lower left of the right frame of the dialog.  
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2) See the results below.  This adds a Label tab at the top of the dialog and also the ability to copy 
labels, create labels, create folders, etc.   

 
 

3) Select the Label button at the top of left of the dialog.   

 
  



ANNOTATION  Civil Labeler  

                                     134  
               

4) Review the dialog with the Label tab chosen.  This is where the label is set up.  Review the 
dialog below.  Disable the View Independent button if it is enabled.  Note that if this setting is 
enabled, when a view rotates, the label will rotate with the view.  This is nice for some labels 
such as curve labels so the text stays readable at all times, but not ideal for Bearing and Length 
labels placed on the same angle as the element that is being rotated.   

 
5) Choose the Save file as command.   

 
6) You should be prompted with a Select Wizard dialog.  Choose No wizard and then you should be 

prompted with a Save Document As dialog as shown below.  Choose the Select button to select 
the folder to save this XML to. 

 



ANNOTATION  Civil Labeler  

                                     135  
               

7) Select the folder below under your project.   

 
8) Returning to the Save file as command, name the file WorkSetName_Civil Labeler.xml   

 
 
NOTE: If it is named WorkSetName_Civil Labeler.xml and place it in the Feature Definition folder 
then that .xml will load instead of the one from the WorkSpace when you open Civil Labeler in 
future ORD sessions.  
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9) You will be prompted by PW to Check In this XML file.   Check it in.   

 
 

10) Now, notice by looking at the top of the dialog that you are pointing at your own custom XML 
file. 

 
 
 

11) Choose the Placement toggle at the top of the dialog to move back into the placement mode.  
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11.2.3 Plan & Profile Annotation 

Annotation of Plan & Profile should be performed in design or drawing models.  The coordinate 
system is valid in the Plan View drawings models so Civil Accudraw can be used to locate 
Station/Offset or coordinate values.  Below are a few examples of manually annotating Plan and 
Profile models. 

11.2.3.1 Profile Annotation 
1) Remaining in 12345_RD_Plan Profiles_CR44.dgn, open the Profile 2 Model.  You should see 

the channel around 11+00.  We will label Station/Elevation of a few of the VPI’s of this ditch.   

 
 

2) Select the ribbon tab Drawing Production and the command Civil Labeler. 
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3) Navigate to the Profile folder, choose the Station-Elevation labels and click Place. 

 
 

4) You are prompted to Identify Profile.  Select the existing profile and then snap to the lower right 
of the channel bottom to identify the point to label.   
 

   
 

5) A label should appear on your cursor as shown below.   
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6) Move the label to the approximate location shown below and data point to place the label.   
The station/offset should change to the actual station/offset.   
 

 
 

7) Continue labeling a few more Ditch VPI’s.   

11.2.3.2 Plan Annotation 
1) Open the Plan 5 View Group 

 
 
We will label the intersection of CR44 with US85-SB & NB alignments.   
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2) Hover over the US85 SB alignment and you should see a LT_EOP_IN element.  Turn this level off 
using the Reset menu.  This is done to make the US85 alignments easily selectable in the next 
steps.   

 
3) Select the ribbon tab Drawing Production and the command Civil Labeler. 

 

 
 

4) Navigate to the Roadway Design\Plan\Intersecting Elements folder, choose the Intersecting 
Geometry – Stations [with Names] label and click Place. 
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5) Once prompted to Identify First Alignment, choose the US85-SB alignment. 
 

 
 

6) Once prompted to Identify Second Alignment, choose the CR44 alignment. 

 
7) A label pointing to their intersection should appear. 
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8) Data Point to place the label in the area shown below and then Reset to exit the 
command.  

 
9) Label the CR44 / US85-NB intersection as shown below.  
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11.2.4 XS Annotation 

11.2.4.1 Offset/Elevation labels   
1) Open 12345_RD_XS_CR44.dgn & the cross section drawing model 3+00. 

 
2) Select the ribbon tab Drawing Production and the command Civil Labeler. 

 

 
 

3) Navigate to the Cross Section folder, choose the Offset Elevation label and click Place. 
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4) Snap to the Left Ditch and move your cursor to where you want to place the label. 
 

 
 

5) Data point to get the correct elevation/offset and to place the label. 

 
  



ANNOTATION  XS Annotation  

                                     145  
               

11.3 XS Annotation 

11.3.1 Annotation Groups 

As mentioned in the Cross-Section section of this manual, the initial annotation group used when cross-
section sheets are created is one of the XS Grid – Offset/Elev * shown below.  These draw the XS Grid, 
annotates slopes, and uses the inline offset annotation with no flags.    

 
 
This initial annotation is shown below.  

 
 
Available annotation group folders are shown below and then examples are given after that showing 
what most of these will produce.    
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11.3.2 Grid-Offset/Elev 

 

11.3.3 Flags 

 

11.3.4 Grid 
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11.3.5 Offset/Elev (Inline) 

 

11.3.6 Offset/Elev (Parallel) – Flags 

 

11.3.7 Offset/Elev (Parallel) 
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11.3.8 Grid – Offset/Elev – Flags 

 

11.3.9 Others 

The following annotation groups that are not under a folder categorization are for the most part, self-
explanatory.   We have already been through the XS End Area Volume and we will go through adding 
ROW in section 11.5 below. 

 

11.3.10 Removing Annotation Groups 

Note that running an additional XS annotation group will add to the annotation that is already present 
which in some cases could create overlaps in text.   If you wish to replace an annotation group, you will 
need to use the Remove Drawing Model Annotations and then use the Drawing Model Annotation 
command to add the new group(s).  When you use the Remove Drawing Model Annotations command, 
you can’t choose an annotation group to remove so currently, all annotation is removed.  The Remove 
Annotation command is demonstrated in the section below. 

11.4 Corridor Changes 
If anything about the Corridor model changes (profile, superelevation, model changes such as pavement 
width, ditch depth, shoulder width, pavement depth, etc.) the annotation will need to be updated.  
Steps below go through this process. 
 
In the steps below, we will assume the design profile has changed on the CR44 alignment and the 
corridor model has changed.  To update the annotation on the cross-sections: 

1) Open the file 12345_Rd_XS_CR44.dgn 
2) Although you can go to any of the cross-section drawing models to perform the update, we will 

go to CR44 - 3+00.00 
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3) This model should look similar to what is shown below.  

 
4) Choose – Drawing Model Annotation - > Remove Drawing Model Annotation 

 
5) Put a check in the All Drawing Models check box.  

 
 

6) Data point to confirm all models.  All annotation except the label placed by the Civil Labeler has 
been removed.  

 
7) Choose the Drawing Model Annotaion -> Annotate Drawing Model 
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8) Check the All Drawing Models checkbox and choose the Annotation Group shown below.  

 
9) Confirm the prompts and the updated grid, offset/elevation offset labels, station, etc. should 

appear. 
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10) You would also have to choose and run any other annotation groups (such as XS End Area 
Volumes, Flags – Right of Way, etc.  We will not do this but you would do the following to 
update the earthwork.  
a. Open the Multi-model view of the XS file. 
b. Run the End Area Volume Report again to update the earthwork based on the profile 

change.  
c. Go back to one of the XS drawing models 
d. Choose the Drawing Model Annotation command. 
e. Choose the XS End Area Volumes annotation group and data point to confirm the prompts 

and the earthwork should be added back.   
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11.5 Adding ROW 
We will go through the steps of showing the location of proposed right of way on cross-sections.  
This process will work for existing and proposed ROW and also Easement.  To accomplish this, 
you must profile the existing and/or proposed ROW which is performed in the first few steps 
below and then we will apply an annotation group in the XS file.   

  
1) Open the file 12345_Rd_ROW_Prop.dgn.  This is just a 2D file so we will reference the terrain & 

set it active so we can profile the ROW. 
 

2) Turn OFF all references including  12345_RD_ROW_EX.DGN which should already be off.   

  
 

3) Attached the Existing Ground Terrain from the Survey folder.  The file name is 
12345_SV_Terrain.DGN9 
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4) Set the Terrain Active. 

 
 

5) Turn OFF display of the Default-3D reference file of the Default model in view 1. 

 
6) On the feature definition toolbar (available under Geometry -> General Tools -> Standards), 

choose Match Feature (1 below).  Select one of the proposed ROW lines to set the feature to 
Right of Way (Prop) and then set the Use Active Feature toggle on (2 below).   
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7) Select all the proposed ROW elements. 

 
8) Select the Profile from Surface command.     

 

 
9) Fill out the dialog as shown below. 

 

 
 

10) Data Point as prompted.  
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11) Select the terrain model and then confirm all the prompts to profile all the elements. 
 

 
 

12) From the Reset menu, open the Plan/3D views and make sure the ROW lines are profiled.   
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13) Open the 123455_RD_XS_CR44.DGN file and referenced 12345_RD_ROW_Prop. 
 

14) Open the Drawing Model of CR44 – 15+00 
 

 
 

15) Choose Annotate Model from the Drawing Production ribbon tab.   
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16) Set the Annotation Group as shown below.  
 

 
 

17) Check on All Drawing Models and confirm with data points the remaining prompts. 
 

 
 

18) Review the Proposed ROW label placed on the cross-sections.   
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11.6 Patterning & Hatching 

11.6.1 Overview 

Pattern tools are available on the Drawing workflow as shown below.  

 
 
There are also a couple of Pattern/Hatch tools available on the CDOT menu as shown below.   These 
tools on the CDOT menu will set the level, kick off the command, and set the Pattern cell.  

 
 

11.6.2 General process 

 
1) Open the file 12345_RD_PavemenrRemovalShading.dgn 
2) There are multiple pavement removal shapes in this file that need to be cross-hatched (red 

below) and one shape that has been cross hatched (Yellow below).   
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3) Go to Drawing Production & verify the Drawing Scale is set to 1”=50’. 

 
4) Go to the Drawing Workflow -> Annotate Ribbon tab -> Patterns Ribbon group and choose the 

Match Pattern Attributes 

 
 

5) Ensure that Match Symbology is checked and then select the Yellow cross-hatch area to the left.    

  
 

6)  Go to the Home Ribbon tab and verify that DES_Removals is the active level. 

 
 

7) Go back to the Annotate Ribbon tab and select the Crosshatch command.  
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8) Below are the settings that should be pre-set since you matched the already patterned shape to 
the left.  

 
 

9) Data point in the shapes to flood these areas.   

 
 
NOTE:   
To get the hatching to be placed at an angle along the element, do the following: 
Rotate the view so that the edge of the shape you want to draw the angle from is at horizontal 
and then when you hatch it, the hatching is placed at the intended angle along the shape.    

11.7 Setting up 2D D&U Linear Data For Display on Cross Sections 
Below is a link a supplemental workflow to outline the steps to take MicroStation based 
utility linear data and configure it for annotation of utility data in Cross sections outside of 
the full D&U modeling effort. 

https://www.codot.gov/business/designsupport/cadd/ord/setting-2d-linear-data-in-cross-
sections  
 

  

https://www.codot.gov/business/designsupport/cadd/ord/setting-2d-linear-data-in-cross-sections
https://www.codot.gov/business/designsupport/cadd/ord/setting-2d-linear-data-in-cross-sections
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12. SHEET INDEX 
Sheet Index is found on Project Explorer as shown below and is used to manage DGN files that contain 
your Sheets.  It’s extremely important that all Sheets are created in a Sheet model because Sheet 
Index will only recognize sheet models as sheets.   

 
 
Notice the folder name above matches the workset name for your project shown below.   Sheet Index 
information is stored in the DGNWS file. 
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12.1 Open the Sheet Index for Edits 
1) You can be in any DGN file to access the Sheet Index but let’s open the 12345_RD_Title.dgn file.  
2) Open Project Explorer and select the Sheet Index tab. 
3) Sheet Index is by default, not open for edits so from the sheet index menu, Choose the Open 

Sheet Index for Edit command.  
 

 
 

4) Notice all the commands that appear on the menu.    
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5) Expand the folders as shown below.  
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12.2 Adding Sheets to Sheet Index 

12.2.1 Overview 

There are 3 ways to add sheets to Sheet Index: 
• From the Models dialog -> You can drag & drop a sheet model into a Sheet 

Index folder.   

 
• Through the Sheet Index Add Sheet command -> Shown below. 

 
• Through the Create Drawing dialog -> Check the Add to Sheet Index check box 

on the Create Drawing dialog when creating sheets through the Named 
Boundary process.  The button to the right below will allow you to select the 
Sheet Index folder the Sheet will be placed in.   

 
NOTE: This method will not be discussed below.  
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12.2.2 Drag & Drop a Model 

1) Open the Models dialog and drag and drop the Title [Sheet] model in the Title Sheet folder. 

 
2) Review the added sheet.   

 
 

 
3) Select the Title Sheets folder and review Properties. These settings control the Sheet number, 

Number of digits, Show Leading Zero, etc.  Also note the Total Sheet Count as well.   
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12.2.3 Add Sheet command 

1) Select the Typical Sections folder and choose the Add Sheet command.    

 
 

2) On the resulting dialog, choose the 12345_RD_Typical Sections.dgn file and click OK at the 
bottom of the dialog.  
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3) On the resulting dialog, all sheet models in the previously selected file should be displayed.   
Select the two Sheet models and choose OK. 

 
 

 
4) You may be prompted to Check In the DGN file.  If so, choose the Check In button.   
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5) Expand the Typical Sections folder to see the added sheets.   

 
 
Notice the (3) by the 12345 & PLANS folder which is the total sheets currently in the Sheet index 
for this project.   
 

  



SHEET INDEX  Adding Sheets to Sheet Index  

                                     169  
               

6) Add the following sheets to the specified folders below: 
12345_RD_Tabulation_Fencing.dgn \PLANS\General\Tabulations 
12345_RD_Plan Profiles_US85.dgn \PLANS\Roadway\Plan and Profile 
12345_RD_Plan Profiles_CR44.dgn \PLANS\Roadway\Plan and Profile 
  
 
Review the added sheets below & note that there are now 18 total sheets.  
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7) Choose the Make Sheet Index Read Only button.  

 
 

 
8) You should be prompted to check in the DGNWS file if working in ProjectWise. 
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9) You can actually use Sheet Index to navigate to different models/files.  Double click CR44 – Plan 
1 [Sheet] 

 
10) The model CR44 – Plan 1 [Sheet] in the file 12345_RD_Plan Profiles_CR44.dgn will be opened. 

 
 

11) Open the Sheet Index for edits again. 
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12.2.4 Add Sheet command (from Multiple DGN files) 

You can choose multiple files when performing the Add Sheet command.  We will not perform this 
exercise but the steps in the preceding section can be used and the dialogs below show dialog images 
from steps 2 & 3 when selecting multiple DGN files.   
 

   4  
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12.3 Moving Sheets 
You can select a sheet, hold down your left mouse button, & move a file if needed as shown below 
although we will not move any in this example.  
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12.4 Sheet Border Annotation 
CDOT sheets have been set up with Text Fields on them so they can be populated with Workset 
Properties.   
 

1) Review the title block area of this Plan & profile sheet.  Observe that the Sheet Number 
is 013 for CR44-Plan 1[Sheet].  Notice that you see X’s in several areas.  These are the 
text fields that will change when the Workset Properties are changed which is discussed 
in the next couple of steps.  

 
2) Open the Sheet Index for edits again if it’s not open for edit. 
3) Select the 12345 folder in Sheet Index, right click, and then choose Properties.  Fill out 

the Index Properties as shown below.   
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4) Go back to Project Explorer and choose the Update All Sheet Properties command.  Be 

patient because this is updating title block fields on all sheets. 

 
 

5) Review the changes on the sheet.  Note that you may have to zoom in/out in the view 
for the changes to show up initially.  

 
6) Navigate to PLANS\Roadway\Plan and Profile in Sheet Index and choose CR44 – Plan1 

[Sheet].   
7) Go to Element Properties.  Add your initials as Designer & Detailer and change the 

Sheet Title to CR44.    
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8) Notice the settings on the Title Sheet have not changed to match your edits.  

 
9) Select the Update All Sheet Properties. 

 
 

10) You may have to Zoom In/Out but the settings on the title block should have updated.  

 
 
Note that the edits above just changed one sheet.  You can change multiple sheet 
settings at once by selecting all the sheets you wish to apply the edits to.  Let’s perform 
this in the next few steps.   

11) Select ALL the Plan & Profile sheets and change the Designer & Detailer to your initials. 
12) Select all the US 85-NB Plan & Profile sheets and change the Sheet Title to US85.   
13) Select all the CR44 Plan & Profile sheets and change the Sheet Title to CR44.   
14) Review the Title Block changes based on these last few steps. 
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12.5 Create Folders 
You can create folders, if needed, in the Sheet Index with the command shown below.  

 
 

1) Expand the \PLANS\General folder, select the \General folder, and create a folder 
named \General Notes. 

 
 

2) Move this folder between the \Typical Sections & \Summary Sheets folders just by 
dragging & dropping the folder.  
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12.6 Sheet Properties 
1) Select the workset 12345 in Sheet Index and review Properties. We’ve collapsed Index 

Properties to put the focus on Sheet Numbering Controls which is shown below.  We 
will not change anything here but review what could be changed in regards to Sheet 
Numbering Controls.   

 
2) Select the PLANS\Roadway\Plan and Profile folder & review the Sheet Numbering 

Controls can be folder specific.  Notice the Inherit Naming Rule From Parent is Off so 
any changes to folders above the \Plan & Profile folder would not impact the sheets in 
the \Plan & Profile Shoulder.  

 
 

3) Select the PLANS\General\General Notes folder created in the previous exercise.  Edit 
the properties to match the ones that are set for the Plan and Profile folder (shown in 
the previous step). 

Before Edits After Edits 
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12.7 Sheet Numbers and Sheet Numbering Edits 

12.7.1 Sheet Numbering 

Sheet & Subset Sheet Numbers are calculated by how many sheets are present in the Sheet Index and in 
what order.  These are automatically populated in the Sheet/Subset Sheet fields as shown and 
discussed in the example below. If you add or delete a sheet to the plans, the Sheet Number for all 
sheets below that sheet should update to reflect that additional sheet.   
 

1) You should still be in model CR44 – Plan 1 [Sheet].  Observe the image below.  This 
should explain how the sheet numbers and subset sheet numbers are generated and 
populated from the number of sheets in the folders in Sheet Index.   

 
 

12.8 Add/Delete a Sheet to/from the Plan Set 
Sheet Numbers will automatically populate when new sheets are added or sheets 
already in the Sheet Index command are removed.  We will go through and add a sheet 
to the Sheet Index and make sure the Sheet Number field has been updated in the 
following steps.  

1) Remaining in the- 12345_RD_Plan Profiles_CR44.dgn & the model CR44 – Plan 1 [Sheet], add 
the file, 12345_RD_General Notes.dgn to the PLAN\General\General Notes folder using the 
Add Sheets command. 
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2) Notice that the Sheet Number didn’t change for the model we are in.  It was Sheet 
Number 13.   

 
3) Choose the Update All Sheet Properties.   

 
 

4) Give it a little time to process but the Sheet Number should change from 13 to 14 in the 
CR44 – Plan 1 [Sheet] model. 
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12.9 PDF Creation Process 
 

1) In the Sheet Index, select the 12345 workset and choose Open Print Organizer. 
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2) Choose the desired print style and click OK. 
 

 
 
 

3) Print Organizer is invoked.    
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4) Click the print icon, verify the Destination is correct.  Choose the browse icon to change the 
path and name the file if needed and then click OK.  
 

 
 

NOTE:  A pset is not necessary if the print organizer is launched from the sheet index. 
 

5) View PDF created during the process.  
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